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ABSTRACT

A computer prograrn has been developed for storing information on length distributions
of survey catches on a Macintosh computer. The use of this program on board of
research vessels replaces scoring information with pencil and paper. The output
comprises length distributions by subsampie as weH as raised length distributions of the
total catch by species and haul. as spreadsheet formatted text files. The binary data files
produced can be convened to any format required for further processing after the survey
is completed. After a testing phase. this prograrn is now routinely used during surveys on
board Duteh research vessels.
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1. INTRODUCTION

On boaril research vessels catches are usually tco large to measure every individual fish.
Therefore the catches. are sorted and. split into subsampies, from which length
measurements are taken. Often, more subsarnples of the same species are processed for
different size categories e.g.: all of the larger specimens may be measured. whereas a
subsampie may be taken froni the smaller and more abundant ones. In the past, the fish
lengths were scored on pnnted forms, after which the numbers scored had to be raised to
numbers in the total catch, and subsequently added by species before they could be
punched in the laboratory for funher processing. In addition, preliminary figures for the
catch of cenain species within a specified size range had to be calculated on board for
direct exchange between panicipating countiies.
Depending on the type of survey, the numbers sometimes have to be expressed as
numbers per standard fishing period, e.g. numbers per hour. Different types of survey,
using different gear and different data processing requirements, rriay even be combined in
one cruise. Traditionally, all the additional calculations on the length-frequency
distributions were done on board using a pocket calculator, in between hauls or at the end
of the day. Obviously, these procedures demand a lot of concentration from the starf
involved. In practice, this often resulted in mistakes, panicularly since the data forms
were not always entirely legible (see genuine example in appendix).
After the survey, the length-frequency distribution and trawllists were punched at the
institute for further processing, stock assessments, and production of files for exchange
with other countries within ICES.The data entry programrunningat our institute
frequently "beeped" when it encouritered errors in the length-trequencies, after which the
originaldata had to be re-examined to recover the error. Some errors may never have
been noticed...

All these problems led to the idea to automate tbe on-board registranon and processing of
length measurements. Initially, some attempts were made to use specially prepared
spreadsheets (Microsoft Excel) for the purpose. However, these experiments were not
very successful, because the spreadsheet prograrn proved to be rather slow in calculating
length-frequency distributions from lists of lengths entered, arid because of the skill
required to work with it. In July 1991, when we were on ,board R.V. Tridens for the
annual echo survey for herring, this problem was brought to our attention. Since there
was not much else to do, we decided to statt writing a computer program especially for
storing and processing length measurements on board, using a Macintosh computer.

This paper describes flTSt the program. in the fonn of a "quick reference manual". Some
technical notes on its development follow, after which a descnption is given of the way in
which the progcim is currently bdng used. A running version will be made available to
the theme session.
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2. DESCRIPTION OF THE PROGRAM .;, QUICK REFERENCE
MANUAL

Bessie Turf HEMA has been developed for Dutch research vessels. The version presented
here is merely a 'demo', adapted for an international public by translating a couple of
names and terms in the resource.
Note: we take no responsibilitV whatsoever when this version is used for more than
demonstration pUQJoses.

At start up the following text appears:

Bijzonder Eenuoudig Survey Soorten
Inuoer EHperiment, Trelclcen Uitrelcenen

Razendsnel G' Foutloos •••

DEMO Uersion 2.1.4 (int) - ©R I UO IJrnuiden,
June, 1993.
Ruthors: Henny Wellernan

Marco van der Land (HEMR)

Select "New ••• " to start input. ~r.==(=O=K===:n

When running Bessie Turf, the top strip of the screen displays a menu bar that contains
pull down menus. 'About Bessie' described above is found under the • menu item.

•

\_ File Edit Uiew I 1) I
This reference manual will guide you quickly along the major program options, following
the sequence of the menus and their commands. Mostly, the selection of a menu
command results in the appearance of a dialog box. These boxes contain fields in which
information is asked from the user, and different dialog boxes follow after each other.

HE.\tA The association with the name of the fat female comic strip charaeler. used as an acronym, can't be
explained. We suggest you leam (double) Dutch.

•
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2.1. The File menu

Edit lJiew
New... ~N

Open Datafile... 3€O
Continue lnput WI
(lose ~W

Söue Rom UsL.. ~R

Saue final list... ~f

Print finöl List ... ~p

OüiL, ~Q

~10st cf the actions within Bessie can be found in the pull down menu of File. It contains
items for: creating new data files. reading existing data files and displaying them in the
main dialog box; continuation of input after disposal of the main dialog box. converting
data to text files and quitting.

• As an example we select New••• from the File menu and the ffiain dialog will appear.

Survey type: @ IYFS ODFS
f" ,

OSNS aBTS

[8J Conuert data tö one hour fishing
,,;, ",", "" ".,

•
Date: 122- 6-93

Uessel: ITridens

Haul number: 11-9_9_9 _

ICES rectangle: IL.., _

UAU 0: [8J

K, . Inpul Fish~~~.. »
( Catth Weights... )

[Bytatth - NO FISH.n)

(Saue Data a€S)

(EHit a€E)

Haul characteristics (e.g.• vessel. haul numher. survey) can be entered in the maindialcg
box. The, calculation and sampling methods of four different survey types are
implemented in the program (radio buttons show which one is selected). Data conversiori
to one hour fishing is default for the IYFS and BTS and acheck appears in front of the
string Conuert data.... The conversion rule can be changed by clicking on the check box
after the survey tYPe is defmed.

3
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• As an example, !et's se!ect Input Fish in the main dialog. A new dialog will appear.

•

•

o

( Cancel )

n OK n

Enter Factor:

Selected species:

pipefish (greater)

(SYNGNRTHUS HeUS)

8820020120

Cliclc fishname...

~D~~~:~:~dDCk 111

::~~:~:Dut I
pilchard ~m~

_R1!I1.'1.J.il~I'I~lt~tlll
pipefish (Nilsson's) ~l~j~

~~~h

pipefish (snalce) ~ll~l
l,l,l

pipefishes§im
plaice (European) ~l!!l

~~~~~

pollaclc ~jm

poorcod Irr
rat-fish I rabbit fish I rat tail 11
rau (cuckoo) iQi:

Date is an editable text field in which Bessie will generate today's date. Whenever a haul
is invalid, make sure you rernove the check after UALID.
Frorn this rnain dialog box onwards, the catch data can be given to the prograrn by
choosing Input Fish. Catch Weights or Bycatch - NO F1SH!. Imponant options like writing
data frorn memory to hard disk are performed within this dialog box (after saving, the
title of the window will change from 'New' to the ftle name) .

Fish species are shown in alphabetic order in a scrollable list. The selected species is
displayed to the right of the species list supplemented with the Latin name and the NOne
code.
The subsampling factor for the fish to be measured rnust be entered in the numeric field
behind Enter factor. For a single species. different subsarnpling factors rnay be used.
The program will use these subsampling factors when the total catch per species is
calculated. Pressing the OK button results in a window for entering the length data of the
fish measured.
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. 1 ::' 't.,'

length distribu!ion
I

Mecsured: 13 ',:pipefish'{öriiaterJH;3:
15 1

Enter length:23 2
~

.... .....
25 5

K »26 2 @iJ v, Ente..",.28 1
30 1
34 1 ( RerTloue )

(.Remoue RII )
fjA .-

( OK )
. . .. ., •.. ·:·-a ..... ".- . y. ."" -, ., ." "

.. . "-'.-.. '.'l·.,. - .. -' .... '" -- .
--

This dialog box contains orie mimeric field in which the fish length (ern) ean be typed.
The value in thelength field is processed whenever the enter key is pressed or elieked.
The accepted lengths are displayoo in the window length distribution. Lengths cari be
rernoved simply by using Remoue instead of Enter. Pressing Remoue All does what is
says: rernoval of the entire subsampie.
Pressingthe OK button will show the rnain dialog box again. The two other options,
Catch Welghts and Bycatch... NO FIS"I, will reveal windows with text fields in whieh
riames, kilo's and/or numbers can be filled.
Sinceeomputer memory isvuInerabIe, interim savings to a Bessie data file is strongly
rec.ommended. The first time you choose Saue" data, the possibility is offered to change
the data flIets name or disk location. Bessie data flIes are binary files, which contain. all
the information of one hau!. Qnly Bessie Turf can read these files, the structure of these
data files will be explained later. The icon of the files is given in the following desktop
snapshot:

Once the main dialog box has t>een dismissoo by clicking [Kit, the file menu options Saue
Raw List and Saue Final List can be selected. These options prOduce export text files for
other programs (for instance Microsoft Excel). The difference.between them isthat for
the Final list all subsampies of one fish species are combined and convened to the cateh
per haul or fishing hour. In the Raw list all subsampies are printed separately, just as they
were entered.

5
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Uiew
~H

~C

~U

Cut
Copy
Paste

2.3. The Uiew menu

2.2. The Edit menu

The Edit menu matches the Apple Macintosh standard. When System 7.0 or higher is
used, the Edit menu allows you to Cut. Copy and Paste text within the dialog boxes.
Otherwise, the Edit menu will not be available when dialog boxes are active.

The Uiew menu is unique for Bessie Turf. It is used as a synopsis of fish species and
subsarnpling factors entered for the panicular haul one has selected. In the example haul
above, the Uiew menu shows that three species were entered (Jumpsucl<er, pJaice
(European), and pipefish(greater)). A closer look with the mouse will reveal the
different subsampies with associated factors entered. By selecting one, a confrrmation
dialog box will appear. This dialog box offers the possibility to change the sarnpling
factor and it recalls the length distribution of the sampie, which may also be modified.

6



•

•

3. OEVELOPMENT

3.1; Maclntosh programs and programming

An application prograrn for Macintosh. computers should be seen as a collection of so­
called "resources" of different types. Each resource contains a coded description of a part
of the program: for example, the description of a dialog box and the items it contains, the
descriptionof a menu, a sound, version irifonnation ora list of strings (e.g. the species
names in Bessie Turf). In fact, the compiled program code itself is stored in a number of
resources~ Basically, Macintosh programmers therefore need two tools: a resource editor
for designing the various user interface elemerits (or stealing them from other programs:
games are a great source of weird sounds), and a compiler program for converting the
program cOde into a resource.

Several resource editors for Apple Macintosh are available, as weIl as compiier programs
for various programrning languages. We wrote the program in the "C" programming
language, a language we were familiar with because of our involvement iri the
development of image processing applications at RIVO (in the fields of plankton and
otolith analysis). We used the compiler program TRINK C (version 5.0.4, from
Symantec Corporation), and the resource editor ResEdit (version 2.1.1, from Apple
Computer, Inc.).

From the "C" programming en~ironment calls can be made to standard conmiands or
routines which are buHt into each Macintosh computer, either in ROM (read only
memory, stored in a chip) or in the system software. These commands and routines are
doeumented in the "Inside Macintosh" series. Recently, Apple introduced a new version
of the system software (versiori 7). Bessie Tuif was designed to run under system
software version 6, it will also furiction under the new system 7.

3;2~ Oats structure

As described in the manual above, the data for each haul are storCd in a data file in a
compressed form, which cannot be displayed or printed. The program can only handle
one hau! at a time. The figure below is a schematic representation of the format of the dici
fIles,which is also the format in which the data are kept in the computer's memory when
the program is running. . '... .
The firSt three records contain haul information, infonnation on by-catch (non-fish)
sp6cies, and catch weights. These three records are always present in a daci file and have
a fIXed siie. After these records, the actual length distribution data follow. For, each
spCcies for which data are present, a species record is crea~Cd,eachspecies record linlced
with arie or more subsampie records. The contents of the haul, species and subsampie
fecords is given in the following table:

au!
- survey type
- vessel's name
- date
- hau! number
- hau! duration
etc.

- name
- Lmin / Lrnax
- total number
- total number meaSuied
- total numbers Per length

dass

.Subsam le
- subsampling factor

number measurCd
- numbers measured per

len dass

The way in which the spedes and subsampie records are kept is known as a "linked-lisi"
stnJCtuI'e. It would go beyond the scope of this paper to descrioe the structure in detaiL In
shon: each species record contains a field representing the address (in memory) of the

7
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next species, and a field representing the address of the first subsampie record. Each
subsampie record includes a field representing the address of the next subsampie. The
main advantages of this linked-list structure are its efficient use of memory space
(memory for a species or a subsampie record is allocated only when needed) and its
flexibility (species and subsampies can be added to or removed from the list at any time).

Haul

By-catch

Catch weights

•

•

Rrst species

Second species

Subsampie 1

Subsampie 1

Subsampie 2

Subsampie 2

Schematic representation of the data structure used by Bessie Turf.
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4. THE USE OF THE PROGRAM

After a testing phase, and initial hesitation from some senior scientists resporisible for the
surveys carried out by RIVQ, Bessie Turf is now routinely used on board the. Dutch
research vessels. This chapter describes the procedures currently foUowed, on bOard and
at the institute, and the advantages of using Bessie Turf.

4.1 On board

When the catch is brought on board, it is first sorted on the conveyor belt and
subsequently laid out subsarnple by subsarnple and marked with the associated factor (a
subsarnpie in this context can also be the total catch for a certain species). One ofthe staff
th~n washe~ his or her hands and takes a seat behind the c~niputer in a dry art:a of the
Shlp. Someone else measures the fish which are lying ready. Both people are
communicating through head-sets. headphones and microphories. connected by wii'e.

After all the fish have been measured, Bessie Turf provides the so-called raw and final
lists (the data in readable form). which are then both printed on an ink-jet printer
(Hewlett-Packard Deskwriter 500). By doing this immediately after each haul. and before
the fish are discarded, the data are always safely printed on paper in case anything might
go wrong with the computer. and the files are also backed upon diskettes. Afterprinting.
the raw and final lists may be deleted because they can always be generated again by
Bessie Turf. Tbe binary data file must always be kepl

,.

4.2. At horne

After the survey. the data have to be fed into the RIVO's cenmu computer system(VAX).
In the past, the data had to be typed into the computer at this stage, but now the Bessie
Turf data files are convened into a format, which can b6 read by the VAX-based
programs for further processing. For thisconyersion, aseparate program was developed.
Using this conversion utility, it takes about ten minutes before the results of a 50-haul
survey are ready for tr:insfer.

4.3. Advantages

The advantages of using a program especiaUy designed for the task of storing and
processing ,length distribution data are quite clear. There are much !ess errors in
calculating length distributions for the total catch from subsampies, and this step does not
take anytime any-more. Tbe lists produced are readable(see appendix) lind the data are
available for .funher processing immediately after the survey. Unique names and
obligiuory subsampling factors remove some uncenainties ~at exist in respect of han~
written information. which are often in shonhand (e.g. gumard instead of red or grey
gumard)

4.4. Disadvantages

There are no apparent disadvantages. with one exception: the data typist canrlOt oversee
what is done by the person identifying and measuring the fish. Tberefore a second check,
which may preverit possible mis-identifications or overlooking individual fish. is lacking.
In practice this is solved by assigning a general overview task to another staff member
during this stage.

9



5. RIVO SURVEY SUITE

Bessie Turf is one in aseries (suite) of programs in use or under development at RIVO
for facilitating the collection, processing and display of survey data using Macintosh
computers.

"NeptuNet" is used for logging data from R.V. Tridens' central computer system
(Hydraut). The data provided by Hydraut include nautical information, such as the ship's
position, course, speed, air and water temperatures, etc.

"FishMap" is a program designed to display and print maps of the geographical
distribution of fish species. In practice, it could be used to display any kind of numerical
data, fitting into (sub-divisions of) lCES statistical rectangles. This program will also be
demonstrated in this theme session.

Currently, a prototype of a program for processing data on sex, maturity, age, length and
weight of fish on board research vessels is nearing its completion. In its use, this
program will be similar to Bessie Turf.

ACKNOWLEDGEMENTS

Bessie Turf would not have existed without Martin Wannerdam, who made us do it, and
Frank Storbeck, who told us how to. Niels Daan critically read the manuscript and
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APPENDIX

Example output from Bessie Turf, and an old IYFS form.
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